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Managing Files and 
Folders 
After completing this lesson, you will be able to: 

� View and open folders. 

� Open, edit, and save files. 

� Print files. 

� Sort files. 

� Create files and folders. 

� Move, copy, and rename files and folders. 

� Delete files and folders. 

Files are some of the most important resources you will use in Microsoft 

Windows XP Professional. Every document, picture, or sound you work with is 

a file. Programs (such as Microsoft Word or Microsoft Excel) are actually 

collections of files. Windows itself is a collection of hundreds of files, each 

with its own purpose. For example, one file contains the sound Windows plays 

when it starts, and another contains the sound Windows plays when it shuts 

down. Files even specify the shape of the mouse pointer and the result of 

clicking an item. 

To keep track of all your files, you need to group them in a logical way. In 

Windows, you do this by creating folders, which store related files. Think of a 

folder like a kitchen cabinet. One cabinet might store food, while another stores 

dishes. One cabinet stores flatware, another stores glassware, and a third stores 

glass cookware. In Windows, one folder might store documents you create 

(such as a memo in Word or a workbook in Excel), while another might store 

pictures you download from the Internet. 

You might also divide your kitchen cabinets: a shelf for glassware, another for 

coffee cups, and so on. If you have lots of glasses, you might divide the 

shelves, perhaps water goblets on the left and brandy snifters on the right. In 

Windows, you can have folders within folders to provide additional levels of 

organization. 

When Microsoft Windows XP is installed on a computer, it creates four system 

folders: 

■ Documents and Settings. This folder contains a subfolder for each 

user profile—each user who has logged on to the computer or 

who has logged on to a network domain through the computer. 

Windows XP may create multiple profiles for one person if that 

person logs on in different ways. For example, you might have one 

folder for when you are logged on to the domain and another folder 

for when you are not logged on to the domain. 
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■ Program Files. This is the folder where most programs install the 

files they need in order to run. When you install a new program, you 

are generally given the opportunity to change the installation folder; 

if you accept the default, the program is installed in this location. 

■ temp. The operating system and various other programs might 

store temporary files in this folder. 

■ WINDOWS or WINNT. Most of the critical operating system files 

are stored in this folder. You can look, but unless you really know 

what you are doing, don’t touch! 

Within each profile subfolder in the Documents and Settings folder, Windows 

XP creates three folders: 

■ My Documents. This folder is a convenient place to store 

documents, spreadsheets, and other files you want to access 

quickly. 

■ My Pictures. This subfolder of My Documents has special 

capabilities for handling picture files. 

■ My Music. This subfolder of My Documents has special capabilities 

for handling music files. 

You shouldn’t ever need or want to touch the folders used and created by your 

programs, but knowing how to organize the files you create is essential if you 

want to be able to use your computer efficiently. 

In this lesson, you’re introduced to ways to view and manage your files and 

folders. You learn how to open and close files and folders, how to create and 

delete them, and how to organize them. 

To complete the exercises in this lesson, you will need to use the Part II, 

Lesson02 folder in the Computer Fundamentals Practice folder and some of the 

files it contains: CL Clients, Adventure Brochure Text, AW What’s New, 

Pic00005, Staff, Main Building, and To Do List. 

Viewing and Opening Folders 

The two most popular ways to navigate through folders are to use My 

Computer or Windows Explorer. My Computer displays all the available 

resources on your computer, including icons for disk drives and the network. 

Windows Explorer displays the files and folders on your computer and 

network. 

In Windows, My Computer and Windows Explorer are almost identical. The 

major difference is that the Folders pane appears by default in Windows 

Explorer and not in My Computer. However, you can easily add the Folders 

pane to My Computer by clicking the Folders button on the Standard Buttons 

toolbar. You can open My Computer by double-clicking the My Computer icon 

on the desktop. You can open Windows Explorer by clicking the Start button, 

pointing to All Programs, pointing to Accessories, and then clicking Windows 

Explorer on the Accessories submenu. It’s a matter of personal preference 
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whether you use My Computer or Windows Explorer to view files, folders, and 

other resources. 

When Windows Explorer is first opened, the left side of the window displays 

the Folders pane. The right side of the window displays the contents of the 

folder that is selected in the Folders pane. By default, the My Documents folder 

is selected when you open Windows Explorer. 

To open a folder, double-click it in the Folders pane. When you double-click a 

folder, its contents appear in the right pane, replacing the contents of the folder 

you selected previously. If the new folder contains a subfolder (a folder within 

a folder), you can double-click the subfolder and continue navigating through 

the lower-level folders until you find the file or folder you’re looking for. To 

return to a higher-level folder, click the Up button on the Standard Buttons 

toolbar. To return to other previously opened folders, click the Back button on 

the Standard Buttons toolbar. 

The structure of folders and subfolders might be quite extensive, but you see 

only the top level of folders when you start navigating through the Folders 

pane. Click the plus sign to the left of a folder icon to view all of its subfolders. 

Once a folder is expanded, the plus sign changes to a minus sign. Click the 

minus sign to collapse the list of subfolders so that only the higher-level folder 

appears. You can also double-click a folder to expand it. Double-clicking the 

folder not only expands the folder in the left pane of the window, it also 

displays all of the files and lower-level folders in the right pane of the window. 

On the right side of the Windows Explorer window, you can view your files 

and folders in several different ways. You can view thumbnails or slideshows 

of graphic files, display file and folder types as tiles or icons, or view a detailed 

or not-so-detailed file list. The view options for each folder are available on 

that folder window’s toolbar, and they vary depending on the contents of the 

folder. Available views include the following: 

■ Details view displays a list of files or folders and their properties. 

The properties shown by default for each file or folder are Name, 

Size, Type, and Date Modified. For pictures, the defaults also 

include Date Picture Taken and Dimensions. You can display a 

variety of other properties that might be pertinent to specific types 

of files, including Date Created, Data Accessed, Attributes, Status, 

Owner, Author, Title, Subject, Category, Pages, Comments, 

Copyright, Artist, Album Title, Year, Track Number, Genre, 

Duration, Bit Rate, Protected, Camera Model, Company, 

Description, File Version, Product Name, and Product Version. 

■ Filmstrip view displays the currently selected picture at the top of 

the window above a single row of smaller versions of all the 

pictures in the current folder. This option is available only for the My 

Pictures folder and its subfolders. 

■ Icons view displays the icon and file name for each file or folder in 

the current folder. 

My Documents is the default 

folder for the files you create 

in Windows programs. That 

is, unless you specify a 

different folder when you 

save a newly created 

document, Windows will 

place it in the My Documents 

folder. 
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■ List view displays a list of the files and folders in the current folder, 

with no additional information other than the file name and a small 

icon representing the file type. 

■ Thumbnails view displays up to four miniature representations of 

the files contained in each folder. These thumbnails are displayed 

on top of a folder icon that is about an inch and a half square. 

Thumbnails of individual files display a miniature of the file if it is an 

appropriate type (such as a graphic), or an icon representing the 

type of file. The file or folder name is displayed below the 

thumbnail. 

■ Tiles view displays a large file type icon or folder icon, the file or 

folder name, and up to two additional pieces of information for each 

file in the current folder. The additional information varies 

depending on the type of file. 

Folder Types 

As you examine different folders in Windows Explorer, you might notice that 

some of them look like plain manila folders, while others have a symbol 

embossed on them. In many cases, a folder with an embossed symbol 

represents a Windows component, such as Control Panel. However, three other 

common folder types have special meaning. 

An open folder with a sheet of paper sticking out of it and a cable connection 

beneath the folder represents a network folder, which is a folder shared from 

another computer over the network. A hand holding a folder represents a 

shared folder, which is a folder shared from your computer over the network. 

Windows XP has a variety of special folder types. Storing files of the 

corresponding type in one of these folders enables you to use features that are 

desirable for that type, such as playing music clips or viewing photographs. 

Folder types include: 

■ Documents 

■ Pictures 

■ Photo Album 

■ Music 

■ Music Artist 

■ Music Album 

■ Videos 
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In this exercise, you navigate through folders in Windows Explorer and open 

the Computer Fundamentals Practice folder. 

1 Click the Start button, point to All Programs, point to Accessories, 

and then click Windows Explorer. 

Windows Explorer opens. 

 

2 Click the plus sign to the left of My Computer in the Folders pane. 

The My Computer folder expands to list all of the devices (such as 

disk drives and CD-ROM drives) attached to your computer, as well 

as Control Panel. 

3 Click the plus sign to the left of Local Disk in the Folders pane. (If 

you have more than one local disk, click the plus sign next to the 

one labeled drive C.) 

You might have many folders on this branch because it is your 

primary storage area. 

4 Scroll down the Folders pane until you see the Unlimited Potential 

folder. 

5 Click the plus sign to the left of the Unlimited Potential folder in the 

Folders pane. The Unlimited Potential folder expands to display the 

Computer Fundamentals Practice folder.   

6 Click the Computer Fundamentals Practice folder, then Part II, then 

Lesson02. The practice files appear in the right pane of the window. 

7 Click thrice on the Back button on the Standard Buttons toolbar. 

The My Documents folder reappears because it was the folder 

displayed before you clicked the Unlimited Potential folder. 

8 In the Folders pane, click the minus sign to the left of My Computer. 

The My Computer folder collapses. 

Your screen will not look 

exactly like this one. The 

items shown depend on what 

an individual computer has 

installed on it, as well as 

when it was installed. This 

image is similar to what you 

will see but will not likely be 

identical. 

If there is a minus sign next 

to My Computer, you should 

skip step 2 because the 

folder is already open. 
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Opening, Editing, and Saving Files 

After you have found a file by navigating through the folders in Windows 

Explorer or My Computer, you can double-click the file to open it, and then 

you can modify it as desired. For example, you can edit the text in a document 

or change the colors in a picture. A file is associated with the program that is 

used to read it, so if you double-click a file that was created in Notepad, the 

Notepad program starts and displays the file. If Windows can’t find the 

program associated with the file or if you want to use a program other than the 

associated one, use the Open With command (which is located on the shortcut 

menu that appears when you right-click a file). 

All files have names, and all file names consist of two parts—the name and the 

extension—separated by a period. The type of file or the program in which it 

was created is indicated by the extension. The extension is a short (usually 

three letters, sometimes two or four) abbreviation of the file type. By default, 

Windows XP hides file extensions. If you would prefer to see your file 

extensions, open My Documents (or any folder) in Windows Explorer, and on 

the Tools menu, click Folder Options, and display the View tab. Clear the Hide 

extensions for known file types check box, and then click OK to close the 

dialog box and apply your settings. 

Files also have icons, which are graphic representations of the file type. 

Depending on the way you’re looking at your files, you might see a large icon, 

a small icon, or no icon. 

More About Extensions and Icons 

Whether or not you can see extension and icons, every file has one of each 

assigned to it. The icon that appears with a file name in Windows Explorer 

indicates the program that is associated with that type of file. Some of the more 

common file type extensions and icons include the following: 

 

When discussing file types, 

people often refer to them by 

their extensions only, as in 

“I’m going to e-mail you some 

docs for your review.” 
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File and Folder Names 

File and folder names can be any combination of letters, numbers, and spaces, 

up to 255 characters. Some special characters, such as dashes and commas, are 

allowed in names, while others, such as colons, slashes, and question marks, 

are not. You can avoid having to remember which special characters are 

allowed by just using letters, numbers, and spaces when you create file and 

folder names. 

In this exercise, you open a file using the default program associated with it. 

Then you choose a program to use when opening a file. 

1 If necessary, open Windows Explorer, and click the Maximize 

button in the upper-right corner of the window. 

2 In the Folders pane, click the plus sign to the left of My Computer. 

The My Computer folder expands. 

3 If necessary, click the plus sign to the left of Local Disk, scroll 

down, and then click the Unlimited Potential folder. 

4 Click the plus sign to the left of the Unlimited Potential folder in the 

Folders pane. The Unlimited Potential folder expands to display the 

Computer Fundamentals Practice folder,   

5 Click the Computer Fundamentals Practice folder, then the Part II 

folder, then the Lesson02 folder. The practice files appear in the 

right pane of the window. 

 

 

 

 

 

 

The Local Disk might already 

be expanded when you click 

the plus sign to the left of My 

Computer. 
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6 In the right pane of the Windows Explorer window, double-click the 

Staff file. 

This is an HTML file, so your default browser starts, and the Staff 

file appears in the browser window. 

 

7 Click the Close button in the upper-right corner of the browser 

window. 

The browser window closes. 

8 In Windows Explorer, right-click the file named To Do List. 

A shortcut menu appears. 
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9 On the shortcut menu, click Open With. 

The Open With dialog box appears. 

 

10 Scroll down the Choose the program you want to use list, click 

WordPad, and then click OK. 

Windows personalizes the 

Open With command on the 

shortcut menu. The next time 

you click Open With, a 

submenu appears, showing 

programs you’ve used with 

this command. You can click 

one of these programs, or 

you can click Choose 

Program to open the Open 

With dialog box. 

Windows keeps track of the 

previous 15 files you opened, 

so you don’t have to navigate 

through folders again to 

reopen a file you recently 

opened. To quickly reopen a 

file, click the Start button, 

point to My Recent 

Documents on the Start 

menu, and then click the 

name of the desired file on 

the My Recent Documents 

menu. 



II – 2.10 Computer Fundamentals 
 

The file named To Do List opens in WordPad. 

11 Type Things, and press the spacebar. 

The title in the document now reads Things To Do. 

12 Click the Close button in the upper-right corner of the WordPad 

window. 

An alert box appears, prompting you to save your changes. 

13 Click Yes to save the changes. 

Another alert box appears, warning you that the file will be saved in 

a text-only format that will remove all formatting. 

14 Click Yes to confirm the decision. 

WordPad closes. 

Printing a File 

You can print a file directly from Windows Explorer without first opening the 

file. This can be a great timesaver if you have several documents that don’t 

need to be changed—just printed using the default print settings. 

To print from Windows Explorer, open the folder that contains the file you 

want to print, right-click the desired file, and then click Print on the shortcut 

menu. Windows will open the file using the program that created it, print the 

file, and then close the program and the file. You can also select multiple 

documents for printing from Windows Explorer. Hold down Ctrl, and click 

each file that you want to print. 

In this exercise, you print a document from the Computer Fundamentals 

Practice folder. 

1 If necessary, turn on your printer, and navigate to the Computer 

Fundamentals Practice folder in Windows Explorer, then the Part II 

folder, then the Lesson02 folder. 

2 Right-click the AW What’s New file. 

A shortcut menu appears. 

3 On the shortcut menu, click Print. 

The Notepad window appears briefly, and then it disappears when 

printing starts. 

Sorting Files 

As you work with larger numbers of files, you’ll need to find the files you want 

quickly and efficiently. One way to find a file easily is to group folder contents 

by a certain characteristic, like date. Then if you know the date when you saved 

the file, you can find the file easily. 

There are several ways to view files in Windows Explorer—as large or small 

icons, in a list of file names, in a list with file details (such as when each file 

was last modified), or as file names with thumbnails (small representations of 

To resize a column in the 

Details view of Windows 

Explorer, position the mouse 

pointer over the vertical line 

between column headings. 

The mouse pointer changes 

to a double-headed arrow 

with a line through it. Drag to 

the right to make the column 

wider, or drag to the left to 

make the column narrower. 

Double-click to automatically 

size the column to 

accommodate the widest 

item in it. 



Part II: Lesson 2 Managing Files and Folders II - 2.11 
 

pictures; in this case, the icon representing the file). When you sort files, it’s a 

good idea to display them in Details view. Details view lists each file on a line 

by itself, with columns for the name of the file, the amount of storage space it 

takes, the type of file it is, and the date when it was last saved. In Details view, 

you can click a column heading to sort files by that column. 

In this exercise you view files in Details view, and you sort them by size and 

the date they were most recently modified. 

1 If necessary, open the Computer Fundamentals Practice folder in 

Windows Explorer, and click the Folders button on the Standard 

Buttons toolbar to close the Folders pane. 

You don’t need the Folders pane open right now, because you will 

be working only with the files in the Computer Fundamentals 

Practice folder. 

Tip 

When the Folders view is turned off, the File and Folder Tasks pane 

appears on the left side of the window where the Folders pane was 

previously. This task pane contains options to perform many types of file 

operation, such as renaming files, copying or moving files, deleting files, 

and other options. 

2 Click the Views button on the Standard Buttons toolbar. 

The Views menu appears. The default view, Icons, is selected. 

3 On the Views menu, click Details. 

Each file, including the information pertaining to it, is listed in its 

own row. The files are sorted alphabetically by name. 

4 Click the Size column heading. 

The files are sorted by size, smallest to largest. 

5 Click the Size column heading again. 

The files are sorted by size in reverse order, largest to smallest. 

6 Click the Date Modified column heading. 

The files are sorted by date, oldest to newest. 

7 Click the Views button on the Standard Buttons toolbar. 

The Views menu appears. 

8 Click Icons. 

The folder returns to its default view. 

Creating Files and Folders 

Folders are easy to create in Windows Explorer, and there is no limit to the 

number you can have. So it’s a good idea to think about the way you want to 

organize your folders. You might create a folder for each major project, or for 

each client, or for the months of the year—it depends on how you prefer to 

In Details view, you can 

display many other columns 

of information besides the 

Name, Size, Type, and 

Modified columns. Click View 

on the menu bar, and click 

Choose Details on the View 

menu. The Choose Details 

dialog box appears. In the 

Choose Details dialog box, 

select the check boxes of the 

columns you want to add, 

and then click OK. 
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organize your storage space. For example, the marketing director at Contoso, 

Ltd created a separate folder for Adventure Works. In that folder, there is a 

subfolder for graphics and another for Web pages. 

You can also create files in Windows Explorer. When you create files, you 

create a placeholder for a particular type of content, like a graphic or text file, 

by giving it a name. Then you fill in the content later. This process is the 

opposite of the more typical way to create files, which involves starting a 

program like Notepad, entering data, and then saving the data as a file. 

Creating a file in Windows Explorer has certain benefits over creating a file in 

a program. It’s faster because you don’t have to run the program, and it creates 

structure for the file by predetermining its name and the program that will be 

used to work with it. A few months ago, the marketing director at Contoso, Ltd 

hired a contractor to write some advertising copy. Before the contractor started 

the project, the marketing director created the necessary files so that she 

wouldn’t have to search for them after the contractor completed his job. The 

few minutes the marketing director spent to create the files beforehand saved 

her valuable time later in the project. 

In this exercise, you create two folders, one for Adventure Works and one for a 

freelance copywriter. In the copywriter’s directory, you create shells of the files 

he is to write. 

1 If the Folders window isn’t visible, click the Folders button on the 

toolbar. 

The Folders window appears. 

2 In the Folders window, click the Computer Fundamentals Practice 

folder, if necessary, then the Part II folder, then the Lesson02 

folder. 

3 On the File menu, point to New. 

The New menu appears. 

4 On the New menu, click Folder. 

A new folder named New Folder appears in the window. 

5 Type Adventure Works, and press Enter. 

The new folder is renamed. 

Tip 

You can also create a folder by right-clicking a blank area in the Computer 

Fundamentals Practice folder pane, pointing to New on the shortcut menu, 

and clicking Folder. 

6 Repeat steps 2 through 5 to create a folder named Freelance 

Copy. 

The window should look similar to the following illustration. 

It’s a good idea to limit the 

number of subfolder levels 

within a folder. In general, if 

you have more than three 

levels of folders within 

folders, it gets unwieldy to 

navigate to a particular file—

you keep double-clicking to 

move from a subfolder to its 

subfolder before you finally 

reach the file you want. 
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7 Double-click the Freelance Copy folder. 

The folder is empty. 

8 On the File menu, point to New, and then click Text Document. 

A new file named New Text Document appears in the window. 

9 Type Adventure Works Mystery Weekends.txt, and press Enter. 

The new file is named. 

10 Click a blank area in the folder to deselect the file, and repeat steps 

8 and 9 to create another file named Fall Canoe Trips.txt. 

The Freelance Copy folder now has two empty text files in it. 

11 Double-click Fall Canoe Trips. 

The document is opened in Notepad. 

12 Type Watch for our upcoming schedule of guided canoe trips. 

13 Click the Close button in the upper-right corner of the Notepad 

window, and click Yes to save the changes to the file. 

The Notepad window closes. 

14 Click twice on the Up button on the Standard Buttons toolbar in the 

Freelance Copy window. 

The contents of the Computer Fundamentals Practice folder 

reappear. 

Moving, Copying, and Renaming Files 
and Folders 

Just as you occasionally need to reorganize the space in your closets and 

drawers, you’ll find that you need to reorganize your files and folders. You 

might, for example, want to move files from their current folder to a new folder 



II – 2.14 Computer Fundamentals 
 

you’ve made, or copy a folder so that you have an original version of all its 

contents and a duplicate to experiment with. You might need to rename a file or 

folder to better reflect its contents. 

You can move and copy files or folders using the Move To Folder and Copy To 

Folder commands on the Edit menu in Windows Explorer, or you can simply 

drag a file or folder from one place to another. If you drag a file or folder from 

place to place on the same disk, Windows moves the item. If you drag a file or 

folder from one disk to another disk, Windows copies the item. 

To rename a file or folder, right-click it, and click Rename on the shortcut 

menu. The name of the file is selected. Type the new name, and press Enter. 

The file is renamed. 

To be able to choose whether to copy or move a file or folder that you drag, 

right-click to drag it. When you release the mouse button to drop the item, a 

shortcut menu appears. On the shortcut menu, click either Copy Here or Move 

Here. 

In this exercise, you drag a file to the Adventure Works folder you created in 

the previous exercise. Then you copy a file to the folder using the Copy button 

on the Standard Buttons toolbar. Finally you change a file’s name to better 

describe its content. You must have completed the previous exercise before you 

can complete this one. 

1 In the Part II, Lesson02 folder, click the Adventure Brochure Text 

file, and drag it on top of the Adventure Works folder. 

After a brief pause, the file disappears from the Lesson02 folder. 

2 Double-click the Adventure Works folder. 

The Adventure Brochure Text file appears. 

3 Click the Back button on the Standard Buttons toolbar. 

The Lesson02 folder appears. 

4 Click the Main Building file. 

This file is used for Adventure Works marketing material. 

5 Click the Copy To Folder button on the Edit menu. 

The Copy Items dialog box appears. 

If you use the right mouse 

button to drag files from one 

folder to another, when you 

release the button, a shortcut 

menu appears with options 

for moving or copying the file 

to the new folder. 
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6 Browse to the Adventure Works folder, click it, and then click Copy. 

The Copy Items dialog box closes. Because you copied the file, 

there is no change in the Lesson02 folder. 

7 Double-click the Adventure Works folder. 

The Adventure Works folder now contains two files. 

8 Click the Back button on the Standard Buttons toolbar. 

The Lesson02 folder reappears. 

9 Right-click the Pic00005 file, and on the shortcut menu, click 

Rename. 

The file name is selected. 

10 Type Fall Countryside, and press Enter. 

The file is renamed. 

Selecting Multiple Files 

You learned earlier in this lesson that you can select a single file by clicking it. 

Sometimes, though, you’ll want to select more than one file at a time. For 

example, you might need to move a group of files, or print several files at once. 

There are two ways to select multiple files: 

■ Shift+Click  If the files you want to select are listed one after 

another, click the first file in the group, hold down Shift, and then 

click the last file in the group. 

■ Ctrl+Click  If the files you want to select are not listed together, 

hold down Ctrl while you click each file. If you select a file that you 

If you change your mind 

about renaming a file while 

you’re renaming it (before 

you press Enter or click 

anywhere else), press Esc. 

The file name will return to its 

original name. If you change 

your mind about renaming 

immediately after the new 

name takes effect, click Undo 

Rename on the Edit menu. 
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don’t want to include in the group, hold down Ctrl, and click the file 

again to deselect it. 

Deleting Files and Folders 

Although disk space has become remarkably inexpensive, it’s still a finite 

quantity. Just like any other finite resource, it needs to be conserved by deleting 

unnecessary files and folders. 

Deleting a file or folder doesn’t erase it from the disk the way an eraser 

removes pencil marks. It’s more like tossing something into a junk drawer. 

Eventually, the drawer gets full, and you empty it out. Sometimes, things get 

tossed into the drawer by mistake, and you need to take them out and put them 

back where they belong. 

In Windows, this “junk drawer” is called the Recycle Bin. To send a file or 

folder to the Recycle Bin, select the item, and press the Delete key on the 

keyboard. Click Yes to confirm the deletion. You can also send a file or folder 

to the Recycle Bin by clicking the file or folder to select it, then right-clicking, 

then clicking the Delete option on the shortcut menu. To view the contents of 

the Recycle Bin, double-click its icon on the desktop. To remove an item from 

the Recycle Bin and move it back to its original location on disk, click the item 

to select it, and then click the Restore this item option on the left side of the 

Recycle Bin window. To permanently delete an item in the bin, click the item, 

and then click the Delete option on the File menu. (you can also right-click the 

item and select Delete from the menu that appears.) Click Yes to confirm the 

deletion. To permanently delete everything in the bin, click the Empty the 

Recycle Bin option on the left side of the Recycle Bin window. 

Important 

Permanently deleting a file or folder from the Recycle Bin can’t be undone. 

Use caution, therefore, when you empty the Recycle Bin. You should also 

know that files and folders deleted from a floppy disk or a network are 

permanently deleted—they are not sent to the Recycle Bin. 

In this exercise, you delete a file and a folder, and you restore the deleted folder 

from the Recycle Bin to its previous place. 

1 If necessary, open the Lesson02 folder. 

2 Click the file named To Do List, and click the Delete key on your 

keyboard. 

The Confirm File Delete dialog box appears. 

3 Click Yes to confirm the deletion. 

The file is deleted from the Lesson02 Practice folder. 

4 Click the Freelance Copy folder, click the Delete key on your 

keyboard, and then click Yes to confirm the deletion. 

If you’re sure that you don’t 

need any of the files in the 

Recycle Bin, you can delete 

them permanently without 

opening the Recycle Bin. To 

do this, right-click the 

Recycle Bin, and click Empty 

Recycle Bin on the shortcut 

menu. 

If you delete a file or folder 

that is stored on a network 

drive, the item is permanently 

deleted—you can’t restore it. 

Networks are usually set up 

so that you can delete only 

files or folders that you 

created yourself or shared 

files to which you have full 

access. 
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The Freelance Copy folder is deleted from the Lesson02 folder. 

5 Click the Show Desktop button on the Quick Launch bar. 

The desktop appears. 

6 On the desktop, double-click the Recycle Bin icon. 

The Recycle Bin appears. 

7 Click the Freelance Copy folder. 

The folder is selected, and information about it appears in the 

Details section on the left side of the Recycle Bin window. 

8 In the left side of the window, click the Restore this item option. 

After a brief pause, the Freelance Copy folder disappears from the 

Recycle Bin. 

9 Click the Close button in the upper-right corner of the Recycle Bin 

window. 

The Recycle Bin closes. 

10 Click the Lesson02 button on the taskbar. 

The Lesson02 window reappears, and the Freelance Copy folder is 

back in it. 

11 Double-click the Freelance Copy folder. 

The files in the folder, which were deleted along with it, are restored 

intact. 

12 Click the Close button in the upper-right corner of the Freelance 

Copy window. 

The window closes, and the desktop reappears. 

Lesson Wrap-Up 

In this lesson, you learned how to manage files and folders. You learned about 

Windows Explorer and how to retrieve a particular file. You learned how to 

sort files and print a file without opening it. You also learned how to create, 

move, copy, and rename files and folders. Finally, you learned how to use the 

Recycle Bin to remove files and folders that you no longer need. 

If you are continuing to other lessons: 

■ Close all open windows. The desktop should be displayed. 

If you are not continuing to other lessons: 

1 Close all open windows, and click the Start button on the taskbar.  

2 Click Shut Down on the Start menu. If necessary, click the down 

arrow in the Windows Shut Down dialog box, and click Shut Down 

in the list. Then click OK. (For a non-networked Windows XP 

computer, click the Start button, then click Turn Off Computer, and 

click the Turn Off option in the dialog box that appears.) 

3 After Windows has shut down, turn off the computer and, if 

necessary, all other hardware devices. 
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Quick Quiz 

1 What are the two most popular ways to navigate through folders on 

Windows XP? 

2 How do you open a file? 

3 What type of file has a .mdb file extension? A .wav file extension? 

4 What special characters cannot be part of a file name? 

5 What key combination do you use to select a group of files listed 

one after the other? A group of files not listed together (i.e. not 

adjacent)? 

6 You rename a file and decide right afterwards that you don’t like the 

name. What do you do? 

Putting It All Together 

Exercise 1: In this exercise, you create a compressed folder. Begin by selecting 

the files you want to include in the folder. Next, right-click the selection, and 

on the shortcut menu, point to Send To. Finally, click Compressed (zipped) 

Folder. 

Exercise 2: In this exercise, you explore the online support for Windows XP. 

(Note: You will need a live connection to the Internet to complete this 

exercise.)  Click the Start button, and then click Help and Support. Under Pick 

a Help Topic, click Windows Basics.  Explore some of the online tutorials, 

including Keeping Windows up to date. 


